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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the MG3710A/MG3710E Vector Signal Generator 
MG3740A Analog Signal Generator Operation Manual 
(Mainframe), or MS2690A/MS2691A/MS2692A Signal 
Analyzer Operation Manual (Mainframe Operation). 
Please also refer to them before using the equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 

To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 

following safety symbols to indicate safety-related information. Ensure that you clearly understand the meanings of 

the symbols BEFORE using the equipment. Some or all of the following symbols may be used on all Anritsu 

equipment. In addition, there may be other labels attached to products that are not shown in the diagrams in this 

manual. 

 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 

This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 

about safety items and operation precautions. Ensure that you clearly understand the meanings of the symbols and 

take the necessary precautions BEFORE using the equipment. 

 
 

 
This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution. The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution. The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note. The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 
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19 October 2018 (First Edition) 
21 February 2020 (Fourth Edition) 
 
Copyright © 2018-2020, ANRITSU CORPORATION. 
All rights reserved. No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The contents of this manual may be changed without prior notice. 
Printed in Japan 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange this 

software free-of-charge if it proves defective when used as described in the 
operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for injury or financial loss of the 
customer due to the use of or a failure to be able to use this equipment. 
 
 

Anritsu Corporation Contact 
In the event of this equipment malfunctions, contact an Anritsu Service and 
Sales office. Contact information can be found on the last page of the printed 
version of this manual, and is available in a separate file on the PDF version. 
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Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 
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Software End-User License Agreement (EULA) 
Please read this Software End-User License Agreement (hereafter this EULA) carefully before using 
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios, 
etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this 
software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter 
Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment 
(hereafter Equipment) for the purposes set out in this EULA. 
 
1. Grant of License and Limitations 

1. Regardless of whether this Software was 
purchased from or provided free-of-charge by 
Anritsu, you agree not to rent, lease, lend, or 
otherwise distribute this Software to third 
parties and further agree not to disassemble, 
recompile, reverse engineer, modify, or create 
derivative works of this Software. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer 
this software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for personal 
injury, or any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, arising out of or related 
to your use or inability to use this Software. 

 
 

3. Limitation of Liability 
a. If a fault (bug) is discovered in this Software, 

preventing operation as described in the 
operation manual or specifications whether 
or not the customer uses this software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or exchange the 
software, or suggest a workaround, 
free-of-charge. However, notwithstanding 
the above, the following items shall be 
excluded from repair and warranty.  

i) If this Software is deemed to be used for 
purposes not described in the operation 
manual or specifications. 

ii) If this Software is used in conjunction with 
other non-Anritsu-approved software. 

iii) Recovery of lost or damaged data. 
iv) If this Software or the Equipment has been 

modified, repaired, or otherwise altered 
without Anritsu's prior approval. 

v) For any other reasons out of Anritsu's direct 
control and responsibility, such as but not 
limited to, natural disasters, software virus 
infections, etc. 

b. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs by Anritsu 
engineers necessitated by the above faults 
shall be borne by you. 

c. The warranty period for faults listed in 
article 3a above covered by this EULA shall 
be either 6 months from the date of purchase 
of this Software or 30 days after the date of 
repair, whichever is longer. 
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4. Export Restrictions 
 You may not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by Japanese and 
United States law. In particular, this 
software may not be exported or re-exported 
(a) into any Japanese or US embargoed 
countries or (b) to anyone on the Japanese or 
US Treasury Department's list of Specially 
Designated Nationals or the US Department 
of Commerce Denied Persons List or Entity 
List. By using this Software, you warrant 
that you are not located in any such country 
or on any such list. You also agree that you 
will not use this Software for any purposes 
prohibited by Japanese and US law, 
including, without limitation, the 
development, design and manufacture or 
production of missiles or nuclear, chemical or 
biological weapons of mass destruction. 

5. Termination 
 Anritsu shall deem this EULA terminated if 

you violate any conditions described herein. 
This EULA shall also be terminated if the 
conditions herein cannot be continued for 
any good reason, such as violation of 
copyrights, patents, or other laws and 
ordinances. 

6. Reparations 
 If Anritsu suffers any loss, financial or 

otherwise, due to your violation of the terms 
of this EULA, Anritsu shall have the right to 
seek proportional damages from you. 

7. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with item 5, you shall cease all 
use of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

8. Dispute Resolution 
 If matters of dispute or items not covered by 

this EULA arise, they shall be resolved by 
negotiations in good faith between you and 
Anritsu. 

9. Court of Jurisdiction 
 This EULA shall be interpreted in 

accordance with Japanese law and any 
disputes that cannot be resolved by 
negotiation described in Article 8 shall be 
settled by the Japanese courts. 
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Cautions Against Computer Virus Infection 
● Copying files and data 
 Only files that have been provided directly from Anritsu or generated 

using Anritsu equipment should be copied to the instrument. 
 All other required files should be transferred by means of USB flash 

drive or CompactFlash media after undergoing a thorough virus 
check. 

● Adding software 
 Do not download or install software that has not been specifically 

recommended or licensed by Anritsu.  
● Network connections 
 Ensure that the network has sufficient anti-virus security protection in 

place. 
● Protection against malware (malicious software such as viruses). 

This equipment runs on Windows Operating System. 
To connect this equipment to network, the following is advised.  

 • Activate Firewall. 
 • Install important updates of Windows.  
 • Use antivirus software. 
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Protection Against Computer Virus Infections 
Prior to the software installation 
Before installing this software or any other software recommended or 
approved by Anritsu, run a virus scan on your computer, including 
removable media (e.g. USB flash drive and CF memory card) you want to 
connect to your computer. 
 
When using this software and connecting with the measuring instrument 
● Copying files and data 

On your computer, do not save any copies other than the following: 
 • Files and data provided by Anritsu 
 • Files created by this software 
 • Files specified in this document 

Before copying these files and/or data, run a virus scan, including 
removable media (e.g. USB flash drive and CF memory card). 

● Connecting to network 
Connect your computer to the network that provides adequate 
protection against computer viruses. 

● Protection against malware (malicious software such as viruses). 
To connect your computer to network, the following is advised.  

 • Activate Firewall. 
 • Install important updates of Windows.  
 • Use antivirus software. 

 
 

Cautions on Proper Operation of Software 
This software may not operate normally if any of the following operations 
are performed on your computer: 
● Simultaneously running any software other than that recommended or 

approved by Anritsu 
● Closing the lid (Laptop computer) 
● Turning on the screen saver function 
● Turning on the battery-power saving function (Laptop computer) 
For how to turn off the functions, refer to the operation manual that came 
with your computer. 
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About This Manual 

■Associated Documents 
The operation manual configuration of the MX370113A/MX269913A 5G 
NR TDD sub-6GHz IQproducer™ is shown below.  

■If using MG3710A or MG3710E:  

 

MX370113A/MX269913A  
5G NR TDD sub-6GHz IQproducer™ Operation Manual  

MG3700A /MG3710A/MG3710E Vector Signal Generator 
MG3740A Analog Signal Generator Operation Manual (IQproducer™) 

MG3710A/MG3710E Vector Signal Generator 
MG3740A Analog Signal Generator  
Operation Manual (Mainframe) 

 
 MG3710A/MG3710E Vector Signal Generator MG3740A Analog Signal 

Generator Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3710A, MG3710E Vector Signal Generator and the 
MG3740A Analog Signal Generator.  

---------------------------------------------------------------------------------------------- 

 MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A Ana-

log Signal Generator Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator and the Analog Signal 
Generator. 
---------------------------------------------------------------------------------------------- 

 5G NR TDD sub-6GHz IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of  
the 5G NR TDD sub-6GHz IQproducer™.  

 

Name Used in This Manual 
In this manual, it is assumed that you use MG3710A unless otherwise 
noted. If you use MG3710E, read MG3710A as MG3710E.  
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■If using MS2690A/MS2691A/MS2692A:  

MX370113A/MX269913A  
5G NR TDD sub-6GHz IQproducer™ Operation Manual 

 

MS2690A/MS2691A/MS2692A Signal Analyzer  
Operation Manual (Mainframe Operation) 

MS2690A/MS2691A/MS2692A and MS2830A/MS2840A/MS2850A Signal Analyzer  
Operation Manual (Mainframe Remote Control) 

MS2690A/MS2691A/MS2692A Signal Analyzer  
Option 020: Vector Signal Generator  
Operation Manual (Operation) 

MS2690A/MS2691A/MS2692A Signal Analyzer  
Option 020: Vector Signal Generator 
Operation Manual (Remote Control)

MS2690A/MS2691A/MS2692A and MS2830A/MS2840A 
Signal Analyzer Vector Signal Generator Operation Manual (IQproducer™) 
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 MS2690A/MS2691A/MS2692A Signal Analyzer  

Operation Manual (Mainframe, Operation) 

This describes basic operations, maintenance procedure, common functions 
and common remote functions of the MS2690A/MS2691A/MS2692A. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A/MS2840A/MS2850A  

Signal Analyzer Operation Manual (Mainframe, Remote Control) 

These describe basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A 
or MS2830A/MS2840A/MS2850A.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer  

Option 020: Vector Signal Generator Operation Manual, Operation 

This describes the functions and how to use the Vector Signal Generator 
option. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer  

Option 020: Vector Signal Generator Operation Manual, Remote Control 

This describes how to remotely control the Vector Signal Generator op-
tion.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A/MS2840A  

Signal Analyzer Vector Signal Generator Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator option. 
---------------------------------------------------------------------------------------------- 

 5G NR TDD sub-6GHz IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of  
the 5G NR TDD sub-6GHz IQproducer™.  
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This chapter provides an overview of the MX370113A/MX269913A 5G NR 
TDD sub-6GHz IQproducer™. 
 

1.1 Product Overview ...................................................... 1-2 
1.2 Product Composition ................................................. 1-3 

1.2.1 Restrictions .................................................... 1-3 
1.3 Abbreviation ............................................................... 1-5 
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1.1 Product Overview 
MX370113A/MX269913A 5G NR TDD sub-6GHz IQproducer™ 
(hereinafter referred to as “this software”) is software used to generate 
waveform patterns conforming to the 3GPP 5G NR specifications. These 
are: 

 TS 38.211 V15.6.0 (2019-06) 

 TS 38.212 V15.6.0 (2019-06) 

 TS 38.213 V15.6.0 (2019-06) 
 
This software requires either of the following environment: 

 MG3710A Vector Signal Generator 

 MS2690A/MS2691A/MS2692A Signal Analyzer (hereinafter, “MS269xA”) 
with Vector Signal Generator option mounted 

 Personal computer (hereinafter, “PC”) 
 
This software generates waveform patterns that support the 
specifications of 3GPP 5G NR TDD sub-6GHz with various 
characteristics. This is made possible by the editing/customizing of 
parameters according to its use.  

A waveform pattern created by this software can be output using an RF 
signal after being downloaded into the MG3710A Vector Signal 
Generator , or an MS2690A/MS2691A/MS2692A Signal Analyzer with 
Vector Signal Generator option installed (collectively referred to as 
“mainframe”, or “this equipment”).  
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1.2 Product Composition 
1.2.1 Restrictions 

The following table lists the model name and specifications of this 
software according to the equipment. 

Table 1.2.1-1  Restrictions 

Mainframe 
 

Restrictions 
MG3710A 

MS2690A 
MS2691A 
MS2692A 

Software name MX370113A MX269913A 

Maximum Size of 
Waveform 
Patterns*3 

64 M sample 
128 M sample 
256 M sample 
512 M sample 

256 M sample 

Transmission 
method of 
Waveform 
Patterns 

LAN,  
USB flash drive and other 
external device*1 

USB flash drive and other 
external device*1 

Installation of this 
software to this 
equipment 

Possible  Possible*2 

*1: Transferring waveform patterns is not required if the waveform 
patterns are created on the equipment using this software. 

*2: Although this software can be installed and run in the 
MS2690A/MS2691A/MS2692A, the measurement functions of the 
MS2690A/MS2691A/MS2692A are not guaranteed while this 
software runs. 

*3: The following table shows the relationship between Maximum Size 
of Waveform Patterns and Options.  

Table 1.2.1-2  Maximum Size of Waveform Patterns and Options 

Maximum Size 
of Waveform 

Patterns 
MG3710A-x48/x78 MG3710A-x45/x75 MG3710A-x46/x76 

64 M sample X X X 
128 M sample  X X 
256 M sample X  X 
512 M sample   X 
512 M sample /X /X  

: Installed,  X: Not installed,  /X : Installed or Not installed 
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■Notes on waveform pattern conversion 

The waveform patterns generated with this software varies according to 
the main unit type. If using the waveform pattern to the different main 
unit, you need to convert the waveform pattern.  

For details about how to convert a waveform pattern, refer to each one of 
the following manuals.  

• MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen” 

• MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Signal 
Analyzer Vector Signal Generator Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen”  
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1.3 Abbreviation 
Table 1.3-1  Abbreviation 

Abbreviation Description 
CCE Control channel element 
CORESET Control resource set 
DCI Downlink control information 
DMRS Demodulation reference signal 
PBCH Physical broadcast channel 
PDCCH Physical downlink control channel 
PDSCH Physical downlink shared channel 
PSS Primary synchronization signal 
PTRS Phase-tracking reference signal 
PUCCH Physical uplink control channel 
PUSCH Physical uplink shared channel 
RB Resource block 
SCS Subcarrier spacing 
SSS Secondary synchronization signal 
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Preparation 

This chapter describes the operating environment for this software. 
 

2.1 Operating Environment .............................................. 2-2 
2.2 Installation/Uninstallation ........................................... 2-3 
2.3 Starting Up and Exiting the Software ......................... 2-4 

2.3.1 Starting Software: When installed on other  
than MG3710A .............................................. 2-4 

2.3.2 Starting Software: When installed on  
MG3710A ...................................................... 2-6 

2.3.3 Exiting Software ............................................. 2-8 
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2.1 Operating Environment 
The following environment is required for operating this software on PC. 

(1) PC that meets the following conditions 
OS Windows 7/Windows 10 
CPU Pentium III 1 GHz equivalent or faster 
Memory 512 MB or more 

Hard disk space 

5 GB or more free space in the drive where 
this software is to be installed.  
The free hard disk space necessary to create 
waveform pattern varies depending on the 
waveform pattern size. The free disk space of 
27 GB or greater is required to create four 
maximum (512 Msample) waveform patterns. 

 
(2) If viewing on PC, displays with a resolution of 1024 × 768 pixels are 

best viewed using a small font setting. 
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2.2 Installation/Uninstallation 
This software is included in the IQproducer™ installer. It is 
automatically installed by installing the IQproducer™ that is supplied 
with this equipment or this software. When using a waveform pattern 
created using this software in the equipment, the license file must be 
installed in advance. 

■Installing/Uninstalling IQproducer™ 

For how to install and uninstall IQproducer™, refer to each of the 
following manuals:  

 MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Signal 
Analyzer Vector Signal Generator Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 

■Installing/Uninstalling IQproducer™ license file 

For how to install license file to MG3710A, refer to the following manual:  

 MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™) 
5.1 “Installing License File” 
 

For how to uninstall license file from MG3710A, refer to each one of the 
following manuals:  

 MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 
9.4.4 “Install” 

 
Refer to the following manual for details of how to install/uninstall 
license file to MS2690A/MS2691A/MS2692A with Vector Signal 
Generator option.  

 MS2690A/MS2691A/MS2692A Signal Analyzer Operation Manual 
Mainframe Operation 
3.8 “Installing and Uninstalling”  
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2.3 Starting Up and Exiting the Software 
This section explains how to start and stop this software. 

Note: 
The following explanation assumes the use of Windows 7. The 
screen image may differ slightly if not using Windows 7. 

 

2.3.1 Starting Software: When installed on other than MG3710A 
Start this software using the following procedure.  
The example assumes that it is a PC operation.  

<Procedure> 
1. Click Start on the task bar, and point to All Programs. Next, point to 

Anritsu Corporation, point to IQproducer, and then click 
IQproducer. 

 

2. When IQproducer™ starts, the Select instrument screen is 
displayed. 
On the Select instrument screen, select the model of the main unit 
that uses the waveform patterns created by IQproducer™.  

 

Notes: 
• This software does not support MG3700A, MG3740A, MS2830A, 

and MS2840A. 

• To hide this screen and to start with the selected mainframe's 
screen from the next time, select the Don't show this window 
next time check box. 
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3. The common platform screen is displayed when OK is clicked in the 
Select instrument screen.  
The common platform screen is a screen used to select each function 
of the IQproducer™.  

 
Figure 2.3.1-1  Common Platform Screen 

 
4. Click the System(Cellular) tab on the common platform screen, to 

show the System(Cellular) selection screen that supports each 
telecommunication system.  

5. When installed on other than MG3710A, click 5G NR TDD 
sub-6GHz to display the Normal setup main screen. For details of 
the main screen, refer to Chapter 3 “Normal Setup Screen”. 

 

Figure 2.3.1-2  System(Cellular) Selection Screen 
 

Note: 
If Change Instrument is clicked, the Select instrument screen will 
appear each time the software is loaded.  
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2.3.2 Starting Software: When installed on MG3710A 
Start this software using the following procedure.  

<Procedure> 
1. Press  on the MG3710A front panel to display the common 

platform screen.  
The common platform screen is a screen used to select each function 
of the IQproducer™.  

 
Figure 2.3.2-1  Common Platform Screen 

2. Click the System(Cellular) tab on the common platform screen, to 
show the System(Cellular) selection screen that supports each 
telecommunication system.  

3. When installed on MG3710A, click 5G NR TDD sub-6GHz to display 
the main screen. For details of the main screen, refer to Chapter 3 
“Normal Setup Screen”.  

 

Figure 2.3.2-2  System(Cellular) Selection Screen 
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Note: 
When this software is installed on MG3710A, Change Instrument 
displays instead of Interface Settings. Clicking Interface Settings 
displays the Interface Settings dialog box.  

 
Figure 2.3.2-3  Interface Settings Dialog Box 

 
Here, you can configure interface-related settings of IQproducer™ 
and MG3710A. To return to factory defaults, click Default. 

• Row Socket Port Number 
Sets Row Socket port number. Set the same value as that for 
MG3710A.  

• Wait Time 
Sets the wait time between commands. 
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2.3.3 Exiting Software 
Stop this software using the following procedure. 
■When exiting only this software 
To exit only this software without closing the Common Platform screen, 
or other IQproducer™ tools, do one of these below: 

 Click the Exit button ( ) on the tool bar. 

 Select Exit from the File menu. 

 Click the  button on the upper right screen. 

 

Figure 2.3.3-1  Exiting Software 

 

The operation of the three screen buttons is explained below.  

 

 

Figure 2.3.3-2  Exit Confirmation Dialog Box 

 

 Yes Saves current parameters to file and stops this 
software. 

 No Stops this software without saving current 
parameters to file. 

 Cancel or  Cancels the process and returns to the main screen. 
 
When stopping this software using the Yes button, the saved parameters 
are read at the next start and reset for each parameter.  
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■When exiting entire IQproducer™ application 
To exit all tools of IQproducer™ that are running, select EXIT on the 
Common Platform Screen. In this case, a dialog is displayed to confirm 
stopping of each running tool.  

 
Figure 2.3.3-3  Exiting IQproducer™ 
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This chapter describes the detailed functions when this software is used 
on Normal Setup screen.  

Notes: 

 The examples and screens used throughout this chapter are 
based on the assumption that the IQproducer™ is activated 
with the MG3710A.  

 The MS2690A/MS2691A/MS2692A functions are described as 
notes in each item.  

 
3.1 Screen Details ............................................................... 3-2 

3.1.1 Menu and tool button ........................................ 3-2 
3.1.2 Tree view .......................................................... 3-8 
3.1.3 Common Parameters ..................................... 3-11 
3.1.4 Downlink Parameters ..................................... 3-17 
3.1.5 Uplink parameters .......................................... 3-33 
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3.1 Screen Details 
3.1.1 Menu and tool button 

On common platform screen, click the System(Cellular) tab, and then 
select 5G NR TDD sub-6GHz to display the Normal setup main screen. 

 Menu bar 

Toolbar 

Tree view 

Common parameter list

PHY/MAC parameter list

Error display area 

 

Figure 3.1.1-1  Normal Setup Main Screen 

 

The following table shows the functions of Main screen.  

Table 3.1.1-1  Functions of Main Screen 

Item Function 

Menu bar Displays the operation menu. 
Refer to 3.1.1.1 “Menu Bar”

Tool bar 
Displays the icons with a functions.  

Refer to 3.1.1.2 “Tool bar”

Tree view 
Displays the parameter in the hierarchy structure. 

Refer to 3.1.2 “Tree view”

Common Parameter list 
Displays and edits the common parameters. 

Refer to 3.1.3 “Common Parameter”

PHY/MAC  
Parameter list 

Displays and edits the PHY/MAC parameters. 
Refer to 3.1.4 “Downlink Parameter”

Refer to 3.1.5 “Uplink Parameter”

Error display 
Displays the error message 

Refer to Appendix A “Error message”
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The following table shows the icons and screen functions of Main screen.  

Table 3.1.1-2  Icons and screen functions of Main screen 

Function Operation 

Minimizes the window Click —. 
Maximizes the window Click □.  
Terminates the Window Click ×.  
Expands and reduces the 
window Drag the frame of window. 

Changes the splitting position 
Drag their boundaries to change the splitting position for the 
fields of the tree view, Common parameter list, PHY/MAC 
parameter list, and error display.  

Opens and closes the item Click + to open, or – to close at the leftmost symbol of each 
item in the tree view.  

 

The following table shows the status of items in the PHY/MAC 
parameter list. 

Table 3.1.1-3  Status of items in the PHY/MAC parameter list 

Appearance Status of Parameters 

Black Can be changed. The parameters are related to the generated 
waveforms in the current setting.  

Black italic 

Cannot be changed. The parameters are related to the generated 
waveforms in the current setting.  
The state of each item may change depending on the setting for 
other items. 

Grayed out italic 

Cannot be changed. The parameters are not related to the generated 
waveforms in the current setting.  
The state of each item may change depending on the setting for 
other items. 
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3.1.1.1 Menu bar 

The following table shows the function of the menu bar. 

Table 3.1.1.1-1  Menu bar 

Item Options Description 

File Select Option The presence/absence of the ARB Memory 
Expansion (option) and Baseband Signal 
Combination Function (option) are selected. 
Notes:  

● This function is available only when 
MG3710 is selected in the Select 
instrument screen. If an uninstalled 
option is selected, sometimes the created 
waveform pattern may not be usable. 

● ARB Memory Expansion (option) is not 
available for MS269xA. Only Memory 
256M samples, 1 GB is available.  

  Combinations of Options Maximum Size

  Memory 64M samples None 64M samples 

  Memory 64M samples x2  
(With Option48,78) Option 48 and Option 78 128M samples 

  Memory 256M samples Option 45 or Option 75 256M samples 

  Memory 256M samples x2  
(With Option48,78) 

Option 45 and Option 48,  
or Option 75 and Option 78 512M samples 

  Memory 1024M samples Option 46 or Option 76 512M samples 

  Memory 1024M samples x2 
(With Option48,78) 

Option 46 and Option 48,  
or Option 76 and Option 78 512M samples 

 Recall Parameter File Loads the parameter files saved by the Save 
Parameter File menu.  

 Save Parameter File Saves the current setting parameters to a file. 
 Exit Exits from this software. 
Edit Calculation Generates waveform patterns. 
 Calculation & Load After waveform generation is finished, the 

created waveform pattern is loaded into the 
MG3710A waveform memory. 
Note:  

This function is available only when MG3710 
is selected in the Select instrument screen. 

 Calculation & Play After waveform generation is finished, the 
created waveform pattern is loaded and selected 
at the MG3710A waveform memory. 
Note:  

This function is available only when MG3710 
is selected in the Select instrument screen. 
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Table 3.1.1.1-1  Menu bar (Cont’d) 

Item Options Description 

Edit  
(Cont’d) 

Clipping Displays the Clipping setting screen.  
In this screen, clipping and filtering processing 
can be performed for a generated waveform 
pattern.  

Easy  
Setup 

BS Test Sets the parameters of test models or FRC (Fixed 
Reference Channels) waveform generation that 
are defined in 3GPP TS 38.141-1 V15.0.0 
(2018-12) or V15.2.0 (2019-06). 

Transfer 
Setting 

Transfer Setting Wizard Displays the Transfer Setting Wizard screen. 
Every operation ranging from connecting the PC 
and MG3710A and transferring the waveform 
pattern to the MG3710A, to loading the waveform 
pattern into the MG3710A ARB memory is 
performed at this screen.  
Note:  

This function is available only when MG3710 
is selected in the Select instrument screen. 

Simulation CCDF Displays the CCDF Graph Monitor screen. In this 
screen, the CCDF of the generated waveform 
pattern is displayed in a graph. 

 FFT Displays the FFT Graph Monitor screen. In this 
screen, the FFT-processed spectrum of the 
generated waveform pattern is displayed in a 
graph.  

 Time Domain Displays the Time Domain screen. In this screen, 
the time domain waveform of a generated 
waveform pattern is displayed in a graph. 
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3.1.1.2 Tool bar 

The following table shows the function of the tool bar.  

Table 3.1.1.2-1  Tool bar 

Icon Name Description 

  Recall Parameter File Each icon performs the same operation as the 
option with the same name on the menu bar.  

Refer to Table 3.1.1.1-1 Menu bar   Save Parameter File 

  Calculation 

  Calculation & Load  

  Calculation & Play  

 Transfer & Setting Wizard  

 CCDF  

 FFT  

 Time Domain  

 Clipping  

  Exit  
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3.1.1.3 Screen transition 

Figure 3.1.1.3-1 shows transition from the main screen that is displayed 
when the 5G NR TDD sub-6GHz IQproducer™ is started up to other 
screens (Export File, Calculation, and Frame Structure screens). For 
details on each of the screens, refer to the sections shown below the 
corresponding screen. 

 

OK

Normal setup main screen 

Cancel

Calculation

Calculation completed: 
[OK] button 

During calculation: 
[Cancel] button 

Export File screen 
(Refer to 3.1.8 “Export File screen.”)

Calculation screen for waveform generation 
(Refer to 3.1.9 “Calculation screen”.) 

 

Figure 3.1.1.3-1  Screen transition 
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3.1.2 Tree view 
The tree view displays the parameter that belongs to the waveform 
pattern to be created in the hierarchy structure. 

● The PHY/MAC parameter list shows the parameter list for the items 
selected in the tree view. 

● When Downlink/Uplink in the common parameter list is switched, the 
menu displayed in the tree view changes as well.  

 
Common– 

Downlink+

Common– 
Uplink +

or 

 

Table 3.1.2-1  Common Tree View 

 

The following table shows the menu when the item is right-clicked in the 
tree view.  

Table 3.1.2-1  Right-clicked menu of the item in the tree view 

Example Item Function 

Slot #0 to 19 Copy Copies the parameters of the selected slot 

 
Paste Applies the copied settings to the selected 

slot parameter. 
 Paste all Applies the copied settings to all slot parameters. 



 

3.1 Screen Details 

3-9 

3 

N
orm

al S
etu

p S
creen

  

3.1.2.1 Downlink Tree view 

 
Common– 
– Downlink

–

–

SS Block

–

PBCH 

Synchronization signals

Slot #0 

PDCCH 

– CORESET #0

DCI #0 

DCI #(Number of DCIs – 1) 

– CORESET #(Number of CORESETs – 1) 

DCI #0 

DCI #(Number of DCIs – 1) 

– PDSCH #0 

DMRS 

– PDSCH #(Number of PDSCHs – 1) 

DMRS 

– Slot #(MaxSlotNumber – 1)

PDCCH 

PDSCH #0 

PDSCH #(Number of PDSCHs – 1) +
+
+

 

Number of DCIs: 1 to 8 
Number of CORESETs: 1 to 3 
Number of PDSCHs: 1 to 8 
MaxSlotNumber: Refer to Table 3.1.4.4-2 

Figure 3.1.2.1-1  Downlink Tree View 
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3.1.2.2 Uplink Tree view 

 
Common– 
– Uplink 

–
– Slot #0 

PUSCH #0

DMRS 

– PUSCH #(Number of PUSCHs – 1) 

–
– Slot #(MaxSlotNumber – 1)

PUSCH #0

– PUSCH #(Number of PUSCHs – 1) 

DMRS 

DMRS 

DMRS 
 

Number of PUSCHs: 1 to 8 
MaxSlotNumber: Refer to Table 3.1.5.1-2 

Figure 3.1.2.2-1  Uplink Tree View  
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3.1.3 Common Parameters 
When Common is selected in the tree view, the following items are 
displayed in the Common parameter list. The following table shows the 
items in the Common parameters.  

Table 3.1.3-1  Common Parameters 

Item Function 

Common  

Test Model 

Selects the Test Model.  
Options: Off (Default), NR-FR1-TM1.1, NR-FR1-TM1.2,  

NR-FR1-TM2, NR-FR1-TM2a, NR-FR1-TM3.1,  
NR-FR1-TM3.1a, NR-FR1-TM3.2, NR-FR1-TM3.3 

Test Model Version 
Selects the the version of Test Model reference specification.  
Options: 38.141 V15.2.0 (2019-06) (Default) 

38.141 V15.0.0 (2018-12) 

Test Model TDD 
Configuration  

Sets the test model slot configuration.  
Options: D(DownLink Slot), S(Special Slot), U(Uplink Slot) 
Remarks: Double-click on Test Model TDD Configuration 

displays the Test Model TDD Configuration Dialog 
Box.  

Refer to Figure 3.1.3-1 Test Model TDD Configuration Dialog Box

Number of DL Symbols 
in Special Slot 

Sets the number of symbols in special slot 
Range: 3 to 14 

Number of Antennas 
Sets the number of antennas. 
Range: 1 (Fixed) 

Cell ID 

Sets the Cell ID. 
Range: 0 (Default) to 1007 
Resolution: 1 
Remarks: NID(1) and NID(2) are automatically calculated after 

specifying the Cell ID.  

NID(1) 

Sets the Physical-layer cell-identity group. 
Range: 0 to 335 
Resolution: 1 
Remarks: Cell ID is automatically calculated after specifying 

the NID(1).  

NID(2) 

Selects the Physical-layer identity. 
Options: 0 to 2 
Resolution: 1 
Remarks: Cell ID is automatically calculated after specifying 

the NID(2).  
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Table 3.1.3-1  Common Parameters (Cont’d) 

Item Function 

Number of Frames 

Sets the number of frames to be generated. 
Range: 1 to the maximum number of frames  

that can be stored in the waveform memory.
Resolution: 1 
Remarks: Maximum number of frames =  

Maximum number of samples that can be stored in 
the waveform memory / number of samples per frame

 If the size of waveform pattern exceeds 2 GB, the 
maximum number of samples that can be stored in 2 
GB.  

Maximum number of samples that can be stored in the waveform memory
Instrument Maximum Samples 

MS269xA 256M samples: 256 M 

MG3710A 

64M samples:  64 M 
64M × 2 samples: 128 M 
256M samples: 256 M 
256M × 2 samples: 512 M 
1024M samples: 512 M 
1024M × 2 samples: 512 M 

 
Number of samples per frame 

Bandwidth Sample / Frame Bandwidth Sample / Frame

5 MHz 
10 MHz 
15 MHz 
20 MHz 
25 MHz 
30 MHz 
40 MHz 

76800 × OSR* 
153600 × OSR 
307200 × OSR 
307200 × OSR 
307200 × OSR 
614400 × OSR 
614400 × OSR 

50 MHz 
60 MHz 
70 MHz 
80 MHz 
90 MHz 
100 MHz 

614400 × OSR 
1228800 × OSR
1228800 × OSR
1228800 × OSR
1228800 × OSR
1228800 × OSR

*: OSR: Oversampling Ratio 

Oversampling Ratio 

Selects the oversampling ratio. 
Options: 1, 2, 4, 8 
Remarks: The options are determined by the bandwidth.  

Bandwidth (MHz) Oversampling Ratio 

 5, 10  1, 2, 4, 8 
15, 20, 25  1, 2, 4 
30, 40, 50  1, 2 
60, 70, 80, 90, 100  1 
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Table 3.1.3-1  Common Parameters (Cont’d) 

Item Function 

Sampling Rate 

Displays the calculated value of sampling rate.  
Range: Sampling rate =  

FFT rate (MHz) × Oversampling ratio 
Default: Depends on the default of Bandwidth.  
Remarks: FFT rate (MHz)  

Bandwidth (MHz) FFT Rate (MHz) 
 5  7.68 
10  15.36 
15, 20, 25  30.72 
30, 40, 50  61.44 
60, 70, 80, 90, 100  122.88 

 

Bandwidth 

Selects the system bandwidth. 
Options: As in the following table 

DL/UL SCS Bandwidth (MHz) 

Downlink 15 kHz 5 (Default), 10, 15, 20, 25, 30, 40, 50 
 30 kHz 5, 10, 15, 20, 25, 30, 40, 50, 60, 70, 

80, 90, 100 
 60 kHz 10, 15, 20, 25, 30, 40, 50, 60, 70, 80, 

90, 100 
Uplink 15 kHz 5, 10, 15, 20, 25, 30, 40, 50 
 30 kHz 5, 10, 15, 20, 25, 30, 40, 50, 60, 70, 

80, 90, 100 
 60 kHz 10, 15, 20, 25, 30, 40, 50, 60, 70, 80, 

100 
Remarks: When the bandwidth falls out of range due to 

subcarrier spacing (SCS) change, it is set to the 
closest among valid values. 

Number of RBs  
(Max RB) 

Displays the number of RBs for the current Bandwidth and 
Subcarrier Spacing.  
Default: Depends on the default of Bandwidth.  
Unit: RBs 

Bandwidth (MHz)
SCS (kHz) 

5 10 15 20 25 30 40

15 25 52 79 106 133 160 216
30 11 24 38 51 65 78 106
60 N/A 11 18 24 31 38 51
Bandwidth (MHz)

SCS (kHz) 
50 60 70 80 90 100  

15 270 N/A N/A N/A N/A N/A  
30 133 162 189 217 245 273  
60 65 79 93 107 121 135  
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Table 3.1.3-1  Common Parameters (Cont’d) 

Item Function 

Downlink/Uplink 
Selects downlink or uplink.  
Options: Downlink (Default), Uplink 

Multiplexing Scheme 
Selects CP-OFDM or DFT-s-OFDM for Uplink.  
Displays when Uplink is set.  
Options: CP-OFDM (Default), DFT-s-OFDM 

Cyclic Prefix 
Selects the Cyclic Prefix.  
Options: Normal (Fixed) 

Subcarrier Spacing (SCS) 
Selects the subcarrier spacing.  
Options: 15 kHz (Default), 30 kHz, 60 kHz 

Filter 
Selects whether to filter.  
Options: On, Off (Default) 

Phase Compensation 
Selects whether to perform the Phase Compensation.  
Options: On (Default), Off 

Carrier Frequency 

Sets the Carrier Frequency for performing the Phase Compensation. 
Range: 450 to 6000 MHz 
Resolution: 0.000001 MHz 
Default: 3750 MHz 
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Figure 3.1.3-1  Test Model TDD Configuration Dialog Box 

 

Select D (DownLink Slot) or S (Special Slot) or U (Uplink Slot) from the 
list box of Test Model TDD Configuration. 
The slot number that can be set in the list is  
Slot #0 to Slot #(MaxSlotNumber – 1). 

Refer to Table 3.1.4.4-2 MaxSlotNumber 
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The defaults are set according to SCS as in Table 3.1.3-2 “Test Model 
TDD Configuration Defaults”. 

Table 3.1.3-2  Test Model TDD Configuration Defaults 

SCS (kHz) Test Model TDD Configuration 

15 (10 Slot) D,D,D,S,U, D,D,D,S,U 

30 (20 Slot) D,D,D,D,D,D,D,S,U,U, 
D,D,D,D,D,D,D,S,U,U 

60 (40 Slot) D,D,D,D,D,D,D,D,D,D, 
D,D,D,D,S,U,U,U,U,U, 
D,D,D,D,D,D,D,D,D,D, 
D,D,D,D,S,U,U,U,U,U 
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3.1.4 Downlink Parameters 
When Downlink is selected for Downlink/Uplink in the Common 
parameter list, Downlink is displayed under Common in the tree view.  

When a Downlink is selected in the tree view, the Downlink parameters 
are displayed in the PHY/MAC parameter list. The following items are 
displayed as the Downlink parameters.  

3.1.4.1 SS-Block 

SS-Block parameters are the lower setting items of Downlink 
parameters.  
When SS-Block is selected in the tree view, the following items are 
displayed in the PHY/MAC parameter list.  

Table 3.1.4.1-1  SS-Block 

Item Function 

Downlink  
SS-Block  

Data Status 

Enables or disables the SS-Block. 
Options: Enable (Default), Disable 
Remarks: When Disable is selected, all the SS-Block 

parameters are disabled. 
 When SCS is set to 60 kHz in the Common 

parameters, Data Status of SS-Block is fixed to 
Disable. 

SS-Block Candidate 

Selects the mapping pattern of SS-Block.  
Options: SCS = 15 kHz: A(L=4), A(L=8) (Default) 
 SCS = 30 kHz: B(L=4), B(L=8) (Default), C(L=4), C(L=8)
 SCS = 60 kHz: Cannot be set. 

SS-Block Transmission 

Selects the On/Off for each SS Block.  
Options: On (Default), Off 
Remarks: The setting dialog box is displayed by double-clicked 

item.  
Refer to Figure 3.1.4.1-1 SS Block Transmission Dialog Box

SS-Block Set Burst 
period 

Sets the SS-Block burst period.  
Options: 10 ms (Fixed) 

SS-Block RB Offset 

Sets the frequency offset of SS-Block in RB unit.  
Range: SS-Block Subcarrier Offset = 0: 0 to Max RB – 20 
 SS-Block Subcarrier Offset ≠ 0: 0 to Max RB – 20 – 1 
Default: Floor(Max RB / 2) – 10 

SS-Block Subcarrier 
Offset 

Displays the RE (Resource Element) offset in RB of SS-Block. 
Range: 0 to 11 
Default: Number of RBs is even number: 0 

Number of RBs is odd number: 6 
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Table 3.1.4.1-1  SS-Block (Cont’d) 

Item Function 

SS Subcarrier Spacing 
(SS-Block SCS)  

Displays the subcarrier spacing of SS-Block. It is the same value as 
SCS in the Common parameters.  
Options: 15 kHz, 30 kHz 
Remarks: When SCS (Common parameter) is set to 60 kHz, the 

SS-Block parameters are all disabled. 

Data Mapping 

Selects whether to map the PDSCH data on the SS Block positions 
or not (null). 
Options: PDSCH (Fixed) 
Remarks: Available when Data Status is Disable, or when SCS 

(Common parameter) is set to other than SS-Block 
SCS. 

 Unavailable when SCS is set to SS Block SCS. 
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Figure 3.1.4.1-1  SS-Block Transmission Dialog Box 
 

SS-Blocks can be set to On/Off on the SS-Block Transmission dialog box. 
All the SS-Block Indexes are On by default. 

The SS-Block Indexes from #0 to # (Number of SS-Blocks – 1 ) can be set 
to On/Off on the list. 

The number of SS-Blocks is decided by SS-Block candidate as shown in 
the following table. 

Table 3.1.4.1-2  Number of SS-Blocks 

SS-Block Candidate Number of SS-Blocks 

A(L=4) 4 

A(L=8) 8 

B(L=4) 4 

B(L=8) 8 

C(L=4) 4 

C(L=8) 8 

 
The PHY/MAC parameter list shows the On/Off statuses of the set SS 
Block Indexes in numeric order, separated by commas. 
Example: On,On,On,On,Off,Off,Off,Off 
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3.1.4.2 PBCH 

PBCH parameters are the lower setting items of SS-Block parameters.  
When PBCH is selected in the tree view, the following items are 
displayed in the PHY/MAC parameter list.  

Table 3.1.4.2-1  PBCH 

Item Function 

Downlink  
SS-Block  
PBCH  

Data Type (PBCH) 
Sets the data type to be inserted into the PBCH.  
Options: PN9 (Default), PN15, User File, 16 bit repeat 

Data Type User File 

Sets the user file to be inserted into the PBCH. 
Remarks: This parameter is displayed only when User File is 

selected for Data Type (PBCH).  
Select a user file on the file selection screen and load 
baseband signals. 

Refer to Appendix B User File Format.

Data Type Repeat Data 

Sets the 16-bit repeat data to be inserted into the PBCH. 
Range: 0000 (Default) to FFFF 
Remarks: This parameter is displayed only when 16 bit repeat 

is selected for Data Type (PBCH).  

Init Data 

Sets a initial value for PN data generation. 
Range: 0000 to 01FF ( PN9), 7FFF (PN15) 
Default: 01FF 
Remarks: This parameter is displayed only when PN9 or PN15 

is selected for Data Type (PBCH).  

PBCH Power Boosting  

Sets the PBCH power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 

DMRS for PBCH  

DMRS Power Boosting 

Sets the DMRS power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 
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3.1.4.3 Synchronization signals 

Synchronization signals parameters are the lower setting items of 
SS-Block parameters.  
When Synchronization signals is selected in the tree view, the following 
items are displayed in the PHY/MAC parameter list.  

Table 3.1.4.3-1  Synchronization Signals 

Item Function 

Downlink  
SS-Block  
Synchronization signals  
Primary synchronization signal 

PSS Power Boosting 

Sets the PSS power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 

Secondary synchronization signal 

SSS Power Boosting 

Sets the SSS power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 
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3.1.4.4 Slot 

Slot parameters are the lower setting items of Downlink parameters.  
When Slot is selected in the tree view, the following items are displayed 
in the PHY/MAC parameter list.  

The settings are the same for Slot #0 to #(MaxSlotNumber – 1).  

Table 3.1.4.4-1  Slot 

Item Function 

Downlink  
Slot #0 to #(MaxSlotNumber – 1) MaxSlotNumber: Refer to Table 3.1.4.4-2 

Data Status 

Enables or disables each Slot.  
Options: Enable (Default), Disable 
Remarks: When Disable is selected for a slot, all parameters 

under the slot are disabled. 

Number of PDSCHs 
Sets the number of PDSCHs.  
Range: 1 (Default) to 8 

RB arrangement 

Sets the PDSCH allocation to RB. 
Range: PDSCH #0 to PDSCH #( Number of PDSCHs – 1) 
Default: All RB are PDSCH #0.  
Remarks: Double-click on RB arrangement displays the RB 

arrangement dialog box. 
Refer to Figure 3.1.4.4-1 RB arrangement Dialog Box

 
Table 3.1.4.4-2  MaxSlotNumber 

Subcarrier Spacing MaxSlotNumber 

15 kHz 10 

30 kHz 20 

60 kHz  40 
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Figure 3.1.4.4-1  RB arrangement Dialog Box 

 

Set PDSCH # in the RB arrangement listbox. 

PDSCHs that can be set in the listbox are from PDSCH #0 to PDSCH 
#(Number of PDSCHs – 1). 
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The maximum value of RB is decided by SCS and BW. 

Table 3.1.4.4-3  Maximum Value of RB 

 BW (MHz) 

SCS (kHz) 5 10 15 20 25 40 50 60 80 100 

15 25 52 79 106 133 216 270 N/A N/A N/A

30 11 24 38 51 65 106 133 162 217 273 

60 N/A 11 18 24 31 51 65 79 107 135 

 
All the PDSCHs in the listbox must be used. 

The PHY/MAC parameter list displays the PDSCH numbers in 
ascending order of RBs, separated by commas. 
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3.1.4.5 PDCCH 

PDCCH parameters are the lower setting item of Slot parameters.  
When PDCCH is selected in the tree view, the following items are 
displayed in the PHY/MAC parameter list.  

Table 3.1.4.5-1  PDCCH 

Item Function 

Downlink  
Slot #0 to #(MaxSlotNumber – 1) 
PDCCH  

Data Status 

Enables or disables the PDCCH parameter. 
Options: Enable (Default), Disable 
Remarks: Can be set for each slot. When Disable is selected, all 

PDCCH parameters are disabled. 
Fixed to Disable when PDSCH Mapping Type is B. 

Number of CORESETs 
Sets the number of CORESETs.  
Options: 1 (Default) to 3 

PDCCH ID Data Type 
Selects the data type for PDCCH ID.  
Options: Cell ID (Default), User Defined 

PDCCH ID 

Sets the ID of PDCCH.  
Range: 0 (Default) to 65535 
Remarks: Can be set when PDCCH ID Data Type is User Defined. 

Fixed to Cell ID when PDCCH ID Data Type is Cell ID. 

nRNTI 

Sets the nRNTI (Radio Network Temporary Identifier). 
Range: 0000 (Default) to FFFF  
Remarks: Can be set when PDCCH ID Data Type is User Defined. 

Unavailable when PDCCH ID Data Type is Cell ID. 

Frequency Domain 
Resources 

Sets the arrangement of CORESET in frequency direction. 
Range: Frequency Domain Resource #0 to 44 
Remarks: The upper limit of Frequency Domain Resource is 

calculated by Number of RBs as below. Note that the 
maximum value is 44. 

 Upper limit of Frequency Domain Resource = 
floor(Number of RBs / 6), where floor(x) is the function 
for finding the largest integer that does not exceed x. 

 Double-click on Frequency Domain Resources displays 
the Frequency Domain Resources dialog box. 

Refer to Figure 3.1.4.5-1 Frequency Domain Resources Dialog Box

PDCCH Power Boosting  

Sets the PDCCH power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 

DMRS for PDCCH  

DMRS Power Boosting 

Sets the DMRS power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 



 

Chapter 3  Normal Setup Screen 

3-26 

 

 

 

 

Figure 3.1.4.5-1  Frequency Domain Resources Dialog Box 

 

Select CORESET or DTX from the pulldown menu in the listbox of 
Resource arrangement. 

Not all the CORESETs and DTXs in the listbox need to be used. 

The PHY/MAC parameter list displays the CORESET number or DTX in 
ascending order, separated by commas. 
Example: 0,0,0,0,0,0,0,0,0,1,1,1,1,1,1,1,1,1,1,DTX,DTX,DTX,2,2,2 
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3.1.4.6 CORESET 

CORESET parameters are the lower setting items of PDCCH 
parameters.  
When CORESET is selected in the tree view, the following items are 
displayed in the PHY/MAC parameter list.  

The settings are the same for CORESET #0 to #(CORESET – 1). 

Table 3.1.4.6-1  CORESET 

Item Function 

Downlink  
Slot #0 to #(MaxSlotNumber – 1) 
PDCCH  
CORESET #0 to #(Number of CORESETs – 1) Number of CORESETs:1 to 3 

Start Symbol 
Sets the start symbol of CORESET. 
Range: 0 (Fixed) 

Number of Symbols 
Selects the number of symbols in one CORESET. 
Options: 1 (Default) to 3 

Number of DCIs 
Sets the number of DCIs in one CORESET. 
Range: 1 (Default) to 8 

Number of RBs In One 
CORESET  

Displays the number of RBs per symbol in one CORESET. 
Range: Number of Symbols = 1: 6 

Number of Symbols = 2: 3 
Number of Symbols = 3: 2 

Precoder Granularity 

Sets the Precoder Granularity.  
Options: Same As REG-bundle, All Contiguous RBs (Default) 
Remarks: When set to Same As REG-bundle, the demodulation 

reference signal for PDCCH is mapped only in the 
range allocated to DCI in CORESET. 

 When set to All Contiguous RBs, the demodulation 
reference signal for PDCCH is mapped in the entire 
CORESET. 
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3.1.4.7 DCI 

DCI parameters are the lower setting items of CORESET parameters.  
When DCI is selected in the tree view, the following items are displayed 
in the PHY/MAC parameter list. 

The settings are the same for DCI #0 to #(Number of DCIs – 1).  

Table 3.1.4.7-1  DCI 

Item Function 

Downlink  
Slot #0 to #(MaxSlotNumber – 1) 
PDCCH  
CORESET #0 to #(Number of CORESETs – 1) 
DCI #0 to #(Number of DCIs – 1) Number of DCIs:1 to 8 

CORESET Number 

Displays the corresponding CORESET number. 
Range: 0 to CORESET number – 1  
Remark: Displays the CORESET number of upper layer DCI 

in hierarchy structure. 

First CCE Index In 
CORESET 

Sets the start number of CCE Index in CORESET. 
Range: 0 (Default) to Maximum CCE Index in CORESET 

Aggregation Level 
Selects a value for Aggregation Level. 
Options: 1 (Default), 2, 4, 8, 16 

Data Type (DCI) 
Selects data type to insert into DCI. 
Options: PN9 (Default), PN15, User File, 16 bit repeat 

Data Type User File 

Selects a user file to insert into DCI. 
Remark: Displayed when Data Type (DCI) is User File. 

Select a user file on the file selection screen and load 
baseband signals. 

Refer to Appendix B “User File Format”

Data Type Repeat Data 
Sets data to repeat when 16 bit repeat is selected for Data Type. 
Range: 0000 (Default) to FFFF 
Remark: Displayed when Data Type (DCI) is 16 bit repeat. 

Init Data 

Sets a initial value for PN data generation. 
Range: 0000 to 01FF (PN9), 7FFF (PN15) 
Default: 01FF 
Remark: Displayed when Data Type (DCI) is PN9 or PN15. 
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3.1.4.8 PDSCH 

PDSCH parameters are the lower setting items of Slot parameters.  
When PDSCH is selected in the tree view, the following items are 
displayed in the PHY/MAC parameter list. 
The settings are the same for PDSCH #0 to #(Number of PDSCHs – 1).  

Table 3.1.4.8-1  PDSCH 

Item Function 

Downlink  
Slot #0 to #(MaxSlotNumber – 1) 
PDSCH #0 to #(Number of PDSCHs – 1) Number of PDSCHs:1 to 8 

Data Status 

Enables or disables the PDSCH. 
Options: Enable (Default), Disable 
Remark: Can be set for each slot. 

When Disable is selected, all PDSCH parameters are 
disabled. 

Power Boosting 

Sets the PDSCH and DMRS power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 
Remark: Can be set for each slot.  

Number of Layers 
Selects a number of layers. 
Options: 1 (Fixed) 

Number of Code words 
Selects a number of code words. 
Options: 1 (Fixed) 

Antenna Port Number 

Selects the antenna port number. 
Options: 1000 (Default) to 1003: DMRS Configuration Type is Type1

1000 (Default) to 1005: DMRS Configuration Type is Type2
Remark: Can be set for each slot. 

nRNTI 
Sets nRNTI (Radio Network Temporary Identifier). 
Range: 0000 (Default) to FFFF 
Remark: Common among the slots of the same PDSCH #. 

nID Status 
Enables or disables nID. 
Options: Enable (Default), Disable 
Remark: Can be set for each slot. 

nID 

Sets nID. 
Range: 0 (Default) to 1023: nID Status is Enable 

Cell ID:  nID Status is Disable  
Remark: Can be set for each slot. 

Modulation Scheme 
Selects the modulation scheme. 
Options: QPSK (Default), 16QAM, 64QAM, 256QAM 
Remark: Can be set for each slot. 

PDSCH mapping type 
Selects PDSCH mapping type. 
Options: A (Default), B 
Remark: Can be set for each slot. 
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Table 3.1.4.8-1  PDSCH (Cont’d) 

Item Function 

Symbol Start 

Selects PDSCH symbol start. 
Options: As in the table below. 

PDSCH mapping type DMRS TypeA Position Symbol Start 

A 3 3 (Fixed) 
A 2 0, 1, 2 (Default)
B – 0 (Default) to 12

Remark: Can be set for each slot. 

Symbol Length 

Selects the PDSCH symbol length.  
Options: As in the table below. 

PDSCH mapping type Symbol Length 

A 3 to 14 – Symbol Start (Default) 

B 2 (Default), 4, or 7 
It should be under 14 – Symbol Start.

Remark: Can be set for each slot. 

Symbol End 
Displays PDSCH symbol end. 
Display: Calculated by Symbol Length + Symbol Start – 1 
Remark: Displays for each slot. 

Data Type (PDSCH) 
Selects data type to insert PDSCH. 
Options: PN9 (Default), PN15, User File, 16 bit repeat 
Remark: Common among the slots of the same PDSCH #. 

Data Type User File 

Selects a user file to insert into PDSCH.  
Remark: Common among the slots of the same PDSCH #. 

Displayed when Data Type (PDSCH) is User File. 
Select a user file on the file selection screen and load 
baseband signals. 

Refer to Appendix B “User File Format”.

Data Type Repeat Data 
Sets data to repeat when 16 bit repeat is selected for Data Type. 
Range: 0000 (Default) to FFFF 
Remark: Displayed when Data Type (PDSCH) is 16 bit repeat.

Init Data 

Sets a initial value for PN data generation. 
Range: 0000 to 01FF (PN9), 7FFF (PN15) 
Default: 01FF 
Remark: Common among the slots of the same PDSCH #.  

Displayed when Data Type (PDSCH) is PN9 or PN15.
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3.1.4.9 DMRS 

DMRS parameters are lower setting items under the PDSCH 
parameters. 
When DMRS is selected in the tree view, the following items are 
displayed in the PHY/MAC parameter list. 

Table 3.1.4.9-1  DMRS 

Item Function 

Downlink  
Slot #0 to #(MaxSlotNumber – 1) 
PDSCH #0 to #(Number of PDSCHs – 1) 
DMRS  

nSCID 
Sets nSCID. 
Range: 0 (Default), 1 
Remark: Can be set for each slot. 

DMRS nSCID Data Type 
Selects the data type for DMRS nSCID. 
Options: Cell ID (Default), User Defined 
Remark: Can be set for each slot. 

DMRS nSCID 

Sets DMRS nSCID. 
Range: 0 (Default) to 65535 
Remark: Can be set for each slot. 

Can be set when DMRS nSCID Data Type is User Defined.
Fixed to Cell ID when DMRS nSCID Data Type is Cell ID.

DMRS Length 
Selects the length of DMRS symbol. 
Options: 1 (Fixed) 

DMRS Additional 
Position 

Selects additional positions of DMRS. 
Options: 0 (Default), 1, 2, 3 (as in the table below) 

PDSCH mapping type Symbol Length Options 

A  3 0, 1, 2, 3 
B 2, 4, 7 0, 1 

Other than the above Unavailable 
Remark: Can be set for each slot. 

DMRS Configuration 
Type 

Selects DMRS configuration type. 
Options: 1 (Default), 2 
Remark: Can be set for each slot. 
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Table 3.1.4.9-1  DMRS (Cont’d) 

Item Function 

Number of DMRS CDM 
groups without Data 

Sets whether to insert data into DMRS. 
Range: As in the table below. 

DMRS 
Configuration 

Type 

DMRS 
Length

Number of 
Code 
words 

Antenna 
Port 

Number 
Range Default

1 1 1 1000 1, 2 1 
1 1 1 1001 1, 2 1 
1 1 1 1002 2 2 
1 1 1 1003 2 2 
2 1 1 1000 1, 2, 3 1 
2 1 1 1001 1, 2, 3 1 
2 1 1 1002 2, 3 2 
2 1 1 1003 2, 3 2 
2 1 1 1004 3 3 
2 1 1 1005 3 3 

Remark: Can be set for each slot. 

DMRS TypeA Position 

Selects the DMRS l0 position when PDSCH mapping type is A. 
Options: 2, 3 (Default) 
Remark: Can be set for each slot. 

Can be set when PDSCH mapping type is A. 

DMRS Power Boosting 

Sets the DMRS power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 
Remark: Can be set for each slot. 

Updated to a value as in the table below when 
Number of DMRS CDM groups without Data is set. 

DMRS 
Configuration Type

Number of DMRS CDM 
Groups without Data 

Power 
Boosting 

(dB) 

1 1 0.000 
1 2 3.000 
2 1 0.000 
2 2 3.000 
2 3 4.770 
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3.1.5 Uplink parameters 
When Downlink/Uplink in the common parameter list is set to Uplink, 
Uplink is displayed under Common in the tree view. 

When Uplink is selected in the tree view, the Uplink parameters are 
displayed in the PHY/MAC parameter list. The following sections explain 
the Uplink parameter items. 

3.1.5.1 Slot 

The Slot parameters are lower setting items of the Uplink parameters. 
When Slot is selected in the tree view, the following items are displayed 
in the PHY/MAC parameter list. 

The settings are the same for Slot #0 to #(MaxSlotNumber – 1). 

Table 3.1.5.1-1  Slot 

Item Function 

Uplink  
Slot #0 to #(MaxSlotNumber – 1) MaxSlotNumber:As in Table 3.1.5.1-2. 

Data Status 

Enables or disables data status for each slot. 
Options: Enable (Default), Disable 
Remark: When Disable is selected for a slot, all parameters 

under the slot are disabled. 

Number of PUSCHs 
Sets the number of PUSCH. 
Range: 1 (Default) to 8 

 
Table 3.1.5.1-2  MaxSlotNumber 

Subcarrier Spacing MaxSlotNumber 

15 kHz 10 

30 kHz 20 

60 kHz  40 
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3.1.5.2 PUSCH 

The PUSCH parameters are lower setting items of the Slot parameters. 
When PUSCH is selected in the tree view, the following items are 
displayed in the PHY/MAC parameter list. 

Table 3.1.5.2-1  PUSCH 

Item Function 

Uplink  
Slot #0 to #(MaxSlotNumber – 1) 
PUSCH #0 to #(Number of PUSCHs – 1) Number of PUSCHs: 1 to 8 

Data Status 

Enables or disables PUSCH parameters. 
Options: Enable (Default), Disable 
Remark: Can be set for each slot. 

When Disable is selected, all PUSCH parameters are 
disabled. 

Power Boosting 

Sets the PUSCH and DMRS power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 
Remark: Can be set for each slot.  

Number of Layers 
Selects a number of layers. 
Options: 1 (Fixed) 

Number of Code words 
Selects a number of code words.  
Options: 1 (Fixed) 

Antenna Port Number 

Selects the antenna port number. 
Options: 0 (Default) to 3: DMRS Configuration Type is Type1 

0 (Default) to 5: DMRS Configuration Type is Type2 
Remark: Can be set for each slot. 

nRNTI 
Sets nRNTI (Radio Network Temporary Identifier). 
Range: 0000 (Default) to FFFF 
Remark: Can be set for each slot. 

nID Status 
Enables or disables nID status. 
Options: Enable (Default), Disable 
Remark: Common among the slots of the same PUSCH #. 

nID 
Sets nID. 
Range: 0 (Default) to 1023: nID Status is Enable 

Cell ID: nID Status is Disable 
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Table 3.1.5.2-1  PUSCH (Cont’d) 

Item Function 

Modulation Scheme 

Selects the modulation scheme. 
Options: QPSK (Default), 16QAM, 64QAM, 256QAM, PI/2-BPSK 
Remark: Can be set for each slot. 

When Multiplexing Scheme is DFT-s-OFDM,  
PI/2 – BPSK can be selected.  

 When Data Type (PUSCH) is UL-SCH, a value is 
decided as in the table below and cannot be changed. 

Refer to Table 3.1.5.3-2, Table 3.1.5.3-3

PUSCH mapping type 
Selects PUSCH mapping type. 
Options: A (Default), B 
Remark: Can be set for each slot. 

RB Start 
Sets RB start of PUSCH. 
Range: 0 (Default) to Max RB – 1 
Remark: Can be set for each slot. 

Number of RBs 

Sets the number of RB from RB Start. 
Range: 1 to Max RB – RB Start (Default) 
Remark: Can be set for each slot. 

When Multiplexing Scheme is DFT-s-OFDM, only RB 
that meets the following condition can be set. 

 Number of RBs = 22 × 33 × 55  
(2, 3, and 5 are positive integers) 

RB End Displays RB end of PUSCH. 

Symbol Start 

Selects Symbol Start of PUSCH. 
Options: As in the table below. 

PUSCH mapping type Symbol Start 

A 0 (Fixed) 
B 0 (Default) to 13 

Remark: Can be set for each slot. 

Symbol Length 

Selects Symbol Length of PUSCH. 
Options: As in the table below. 

PUSCH mapping type Symbol Length 

A 4 to 14 – Symbol Start (Default) 
B 1 to 14 – Symbol Start (Default) 

Remark: Can be set for each slot. 

Symbol End 
Displays PUSCH symbol end. 
Range: Calculated by Symbol Length + Symbol Start –1. 
Remark: Displays for each slot. 

Data Type (PUSCH) 

Selects data to insert into PUSCH. 
Options: PN9 (Default), PN15, User File, 16 bit repeat, 

UL-SCH 
Remark: Common among the slots of the same PUSCH #. 

When UL-SCH is selected, Modulation Scheme is 
invalid. 

Refer to 3.1.5.3 “UL-SCH”.
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Table 3.1.5.2-1  PUSCH (Cont’d) 

Item Function 

Data Type User File 

Selects a user file to insert into PUSCH. 
Remark: Common among the slots of the same PUSCH #. 

Displayed when Data Type (PUSCH) is User File. 
Select a user file on the file selection screen and load 
baseband signals. 

Refer to Appendix B “User File Format”.

Data Type Repeat Data 
Sets data to repeat when 16 bit repeat is selected for Data Type. 
Range: 0000 (Default) to FFFF 
Remark: Displayed when Data Type (PUSCH) is 16 bit repeat.

Init Data 

Sets a initial value for PN data generation. 
Range: 0000 to 01FF (PN9), 7FFF (PN15) 
Default: 01FF  
Remark: Common among the slots of the same PUSCH #. 

Displayed when Data Type (PUSCH) is PN9 or PN15.
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3.1.5.3 UL-SCH 

When PUSCH Data Type is set to UL-SCH, the following items are 
displayed in the PHY/MAC parameter list. 

Table 3.1.5.3-1  UL-SCH 

Item Function 

Uplink  
Slot #0 to #(MaxSlotNumber – 1) 
PUSCH #0 to #(Number of PUSCHs – 1) Number of PUSCHs: 1 to 8 
UL-SCH  

Rate Matching 
Select what to use as rate matching. 
Options: FBRM (Fixed value) 
Remark: Displayed when Data Type (PUSCH) is UL-SCH. 

MCS Index 

Specify the MCS Index. 
Range: 0 (Default) to 27 (Table 1, 3), 28 (Table 2) 
Remark: Displayed when Data Type (PUSCH) is UL-SCH. 

Refer to Table 3.1.5.3-3

MCS Table 

Selects a table to use as MCS Table. 
Options: 64QAM (Default), 256QAM 
Remark: Displayed when Data Type (PUSCH) is UL-SCH. 

Refer to Table 3.1.5.3-2

PI/2-BPSK Support 

Selects whether to support PI/2-BPSK. 
Options: Enable, Disable (Default) 
Remark: Displayed when Data Type (PUSCH) is UL-SCH and 

Multiplexing Scheme is DFT-s-OFDM. 
Refer to Table 3.1.5.3-3

Redundancy Version 
Selects Redundancy Version. 
Options: 0 (Default), 1, 2, 3 
Remark: Displayed when Data Type (PUSCH) is UL-SCH. 

Transport Block Size 

Sets the size of transport block. 
Range: 0 (Default) to a value according to PUSCH setting 
Remark: Displayed when Data Type (PUSCH) is UL-SCH. 

The maximum value changes according to PUSCH 
setting. 

Data Type (UL-SCH) 
Selects data to insert into UL-SCH. 
Options: PN9 (Default), PN15, User File, 16 bit repeat 
Remark: Displayed when Data Type (PUSCH) is UL-SCH. 

Data Type User File 

Selects a user file to insert into UL-SCH. 
Remark: Displayed when Data Type (UL-SCH) is User File. 

Select a user file on the file selection screen and load 
baseband signals. 

Refer to Appendix B “User File Format”

Data Type Repeat Data 
Sets data to repeat when 16 bit repeat is selected for Data Type. 
Range: 0000 (Default) to FFFF 
Remark: Displayed when Data Type (UL-SCH) is 16 bit repeat

Init Data 

Sets a initial value for PN data generation. 
Range: 0000 to 01FF (PN9), 7FFF (PN15) 
Default: 01FF 
Remark: Displayed when Data Type (UL-SCH) is PN9 or PN15.
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Table 3.1.5.3-2  Reference Table 

Multiplexing Scheme MCS Table Reference Table 
Standard Table 

(38.214) 

CP-OFDM 256QAM Table 3.1.5.3-3 Table 1 Table 5.1.3.1-2 
CP-OFDM 64QAM Table 3.1.5.3-3 Table 2 Table 5.1.3.1-1 

DFT-s-OFDM 256QAM Table 3.1.5.3-3 Table 1 Table 5.1.3.1-2 
DFT-s-OFDM 64QAM Table 3.1.5.3-3 Table 3 Table 6.1.4.1-1 

 

Table 3.1.5.3-3  Modulation Scheme 

 Table 1 Table 2 Table 3 

MCS Index Modulation Scheme Modulation Scheme Modulation Scheme

0 

QPSK 

QPSK 

q* 
1 
2 

QPSK 

3 
4 
5 

16QAM 

6 
7 
8 
9 
10 

16QAM 16QAM 

11 

64QAM 

12 
13 
14 
15 
16 
17 

64QAM 
64QAM 

18 
19 
20 

256QAM 

21 
22 
23 
24 
25 
26 
27 
28 – – 

*:  q = PI/2-BPSK PI/2-BPSK Support is Enable 
  q = QPSK PI/2-BPSK Support is Disable 
 



 

3.1 Screen Details 

3-39 

3 

N
orm

al S
etu

p S
creen

  

3.1.5.4 DMRS 

The DMRS parameters are lower setting items of the PUSCH 
parameters. 
When DMRS is selected in the tree view, the following items are 
displayed in the PHY/MAC parameter list.  
 

Table 3.1.5.4-1  DMRS 

Item Function 

Uplink  
Slot #0 to #(MaxSlotNumber – 1) 
PUSCH #0 to #(Number of PUSCHs – 1) Number of PUSCHs: 1 to 8 
DMRS  

Group Hopping 
Enables or disables Group Hopping. 
Options: Enable, Disable (Default) 
Remark: Displayed when Multiplexing Scheme is DFT-s-OFDM.

Sequence Hopping 

Enables or disables Sequence Hopping. 
Options: Enable, Disable (Default) 
Remark: Displayed when Multiplexing Scheme is DFT-s-OFDM.

Fixed to Disable when Group Hopping is Enable. 

PUSCH ID 
Sets PUSCH ID. 
Range: 0 (Default) to 1007 
Remark: Displayed when Multiplexing Scheme is DFT-s-OFDM.

nSCID 

Selects nSCID. 
Options: 0 (Default), 1 
Remark: Common among the slots of the same PUSCH #. 

Fixed to 0 when DMRS nSCID Data Type is Cell ID. 

DMRS nSCID Data Type 
Selects DMRS nSCID Data Type. 
Options: Cell ID (Default), User Defined 
Remark: Common among the slots of the same PUSCH #. 

DMRS nSCID 

Sets DMRS nSCID. 
Range: 0 (Default) to 65535 
Remark: Common among the slots of the same PUSCH #. 

Can be set when DMRS nSCID Data Type is User Defined.
Fixed to Cell ID when DMRS nSCID Data Type is Cell ID.

DMRS Length 
Selects DMRS symbol length. 
Options: 1 (Fixed) 

DMRS Additional 
Position 

Selects the number of DMRS additional positions. 
Options: 0 (Default), 1, 2, 3 

PUSCH mapping type Symbol End – Symbol Start Options 

A  3 0, 1, 2, 3 
B (Any value) 0, 1, 2, 3 

Other than the above Unavailable
Remark: Can be set for each slot. 
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Table 3.1.5.4-1  DMRS (Cont’d) 

Item Function 

DMRS Configuration 
Type 

Selects DMRS configuration type. 
Options: 1 (Default), 2 
Remark: Can be set for each slot. 

When Multiplexing Scheme is DFT-s-OFDM,  
DMRS Configuration Type is fixed to 1. 

Number of DMRS CDM 
groups without Data 

Sets whether to insert data into DMRS. 
Range: As in the table below. 

Multiplexing 
Scheme 

DMRS 
Configuration 

Type 

DMRS 
Length

Antenna 
Port 

Number 
Range Default

DFT-s- 
OFDM 

1 1 0 2 2 
1 1 1 2 2 
1 1 2 2 2 
1 1 3 2 2 

CP-OFDM

1 1 0 1, 2 1 
1 1 1 1, 2 1 
1 1 2 2 2 
1 1 3 2 2 
2 1 0 1, 2, 3 1 
2 1 1 1, 2, 3 1 
2 1 2 2, 3 2 
2 1 3 2, 3 2 
2 1 4 3 3 
2 1 5 3 3 

Remark: Can be set for each slot. 

DMRS TypeA Position 
Selects the DMRS l0 position when PUSCH mapping type is A. 
Options: 2, 3 (Default) 
Remark: Can be set for each slot. 

DMRS Power Boosting 

Sets the DMRS power boosting for the ideal signal. 
Range: –20.000 to 20.000 dB 
Resolution: 0.001 dB 
Default: 0.000 dB 
Remark: Can be set for each slot.  

Updated to a value as in the table below when setting 
Number of DMRS CDM groups without Data. 

DMRS 
Configuration Type

Number of DMRS CDM 
Groups without Data 

Power 
Boosting 

(dB) 

1 1 0.000 
1 2 3.000 
2 1 0.000 
2 2 3.000 
2 3 4.770 
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3.1.6 Export File screen 
When “Calculation” is selected from the Edit menu or the   tool 
button is clicked on the main screen, the Export File screen is displayed. 
The Export File screen is displayed when generating a waveform pattern. 
In this screen, the export destination folder, package name, file name, 
and comment for the waveform pattern to be generated can be specified. 

 Export destination folder 
selection button 

Package name 

File name 

Comment 

 

Figure 3.1.6-1  Export File screen 

 

After setting the package name, file name, and comment for the 
waveform pattern to be generated, click OK on the Export File screen.  
The Calculation screen shown in Figure 3.1.7-1 is displayed and 
waveform pattern generation starts (the package name and file name 
must be set to start waveform pattern generation). 
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3.1.6.1 Export destination folder 

Using the export destination folder selection button, set a destination 
folder in the Export Path field to output the waveform patterns created 
by this software. 

The default destination folders are as in the table below. 

Table 3.1.6.1-1  Default Export Destination Folder 

Model with 
MX370113A 

Select 
Instrument

Installed OS Export Destination Folder 

MG3710A MG3710 – C:\Anritsu\MG3710A\ 
User Data\Waveform 

MS269xA MS269x Windows Embedded Standard 7
Windows 10 

C:\Anritsu\Signal Analyzer\ 
System\Waveform 

  Other than the above C:\Program Files\Anritsu Corporation\
Signal Analyzer\System\Waveform 

PC – – See the explanation below. 

 
For PC, the waveform pattern files can be created into the export 
destination folder selected from the Browse for Folder screen. 

 

Figure 3.1.6.1-1  Browse for Folder screen 

 

When the export destination folder is not selected, waveform pattern files 
are created in the “Data” folder under the folder where IQproducer™ is 
installed.  
X:\IQproducer\5GNR\Data 
(“X:\IQproducer” indicates the folder where the IQproducer™ is 
installed.) 
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3.1.6.2 Package Name 

Specify a package name in the Package textbox. Up to 31 one-byte 
characters can be used. 
Invalid characters for Windows cannot be used. 

3.1.6.3 File Name 

Specify a file name in the Export File Name textbox. Up to 20 one-byte 
characters can be used. Only alphanumeric characters and the following 
symbols can be used: 

! % & ( ) + = ‘ { } _ - ^ @ [ ] 

3.1.6.4 Comment 

Enter comments in the Comment textboxes. Up to 38 one-byte characters 
can be used for one textbox. 

The first Comment textbox is read-only and displays characters as below. 

When Phase Compensation is On: 
“Carrier Frequency = (Common > Carrier Frequency value) MHz”  

When Phase Compensation is Off: 
“Phase Compensation = Off” 
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3.1.7 Calculation screen 
Clicking Calculation & Load, Calculation & Play, or the OK button on 
the Export File screen will start the waveform generation.  

The Calculation screen is displayed while a waveform pattern is being 
generated. On this screen, the progress bar is displayed indicating the 
generation process of the waveform pattern and the progress of the 
waveform pattern generation. The generation of the waveform pattern 
can be stopped by clicking Cancel. When cancelled, it returns to the main 
screen.  

 

Progress report 

Progress bar

Cancel button
 

Figure 3.1.7-1  Calculation Screen (In Progress) 

 

After waveform pattern generation is finished, the message “Calculation 
Completed.” is displayed in the progress window and the Cancel button 
changes to the OK button.  

When the generation is complete, you can return to the setting screen by 
clicking the OK button. After waveform generation, two files with .wvi 
and .wvd extension are output.   

 

Figure 3.1.7-2  Calculation Screen (Completed) 

 

Note: 

When using this software on MG3710A, and selecting Calculation 
& Load or Calculation & Play, the waveform generation ends 
without displaying the above screen.  
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3.2 Waveform Pattern Generation Procedure 
3.2.1 5G NR TDD sub-6GHz 

This section describes the waveform pattern generation procedure when 
System in the common parameter list is set to 5GNR. 

3.2.1.1 Downlink 

This section shows a procedure for creating a waveform pattern, using an 
5G NR TDD sub-6GHz downlink waveform pattern as an example. 

<Procedure> 

Procedure for generating Downlink waveform 

1. Start this software.  

2. Set the common parameters as shown in Table 3.2.1.1-1. The 
parameters that are not shown below are used with their default 
values, or are automatically set according to other parameter 
settings. 

Table 3.2.1.1-1  Settings for Common Parameters 

Common 

Test Model Off 
Number of Antennas 1 

Cell ID 0 
NID(1) 0 
NID(2) 0 

Number of Frames 1 
Oversampling Ratio 1 

Sampling Rate 122.88 
Bandwidth 100 

Number of RBs (Max RB) 273 
Downlink/Uplink Downlink 

Cyclic Prefix Normal 
Subcarrier Spacing (SCS) 30 

Filter On 
Phase Compensation On 

Carrier Frequency 3750 MHz 
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3. Click SS-Block in Downlink in the tree view and set the PHY/MAC 
parameters as shown in Table 3.2.1.1-2.  

Table 3.2.1.1-2  Settings for SS-Block 

SS-Block 

Data Status Enable 
SS-Block Candidate B(L=8) 

SS-Block Transmission All On 
SS-Block Set Burst period 10 ms 

SS-Block RB Offset 126 
SS-Block Subcarrier Offset 6 

SS Subcarrier Spacing  
(SS Block SCS) 30 kHz 

 
4. Click PBCH of SS-Block in Downlink in the tree view and set the 

PHY/MAC parameters as shown in Table 3.2.1.1-3. 
Table 3.2.1.1-3  Settings for PBCH 

PBCH 

Data Type PN9 
Init Data 01FF 

PBCH Power Boosting 0.000 dB 

DMRS for PBCH 

DMRS Power Boosting 0.000 dB 

 
5. Click Synchronization signal of SS-Block in Downlink in the tree 

view and set the PHY/MAC parameters as shown in Table 3.2.1.1-4.  

Table 3.2.1.1-4  Settings for Synchronization signal 

Synchronization signal 

Primary synchronization signal 

PSS Power Boosting 0.000 dB 

Secondary synchronization signal 

SSS Power Boosting 0.000 dB 

 



 

3.2 Waveform Pattern Generation Procedure 

3-47 

3 

N
orm

al S
etu

p S
creen

  

6. Click Slot #0 in the tree view and set the PHY/MAC parameters as 
shown in Table 3.2.1.1-5.  

Table 3.2.1.1-5  Settings for Slot #0 

Slot #0 

Data Status Enable 
Number of PDSCHs 1 

RB arrangement All PDSCH #0 

 
7. Click PDCCH in Slot #0 in the tree view and set the PHY/MAC 

parameters as shown in Table 3.2.1.1-6.  

Table 3.2.1.1-6  Settings for PDCCH 

PDCCH 

Data Status Enable 
Number of CORESETs 1 
PDCCH ID Data Type Cell ID 

PDCCH ID 0 
nRNTI 0000 

Frequency Domain Resources Refer to the procedure 9. 
PDCCH Power Boosting 0.000 dB 

DMRS for PDCCH 

DMRS Power Boosting 0.000 dB 

 
8. Click CORESET #0 in PDCCH in Slot #0 in the tree view and set the 

PHY/MAC parameters as shown in Table 3.2.1.1-7.  

Table 3.2.1.1-7  Settings for CORESET #0 

CORESET #0 

Start Symbol 0 
Number of Symbols 2 

Number of DCIs 1  
Number of RBs In One CORESET 3 

Precoder Granularity All Contiguous RBs 

 
 



 

Chapter 3  Normal Setup Screen 

3-48 

9. Double-click RB arrangement of Slot #0 in the tree view and set 
CORESET #0 to Resource #0 as in Figure 3.2.1.1-1.  

 

Figure 3.2.1.1-1  RB arrangement 

 
10. Click DCI #0 of CORESET #0 in PDCCH in Slot #0 in the tree view 

and set the PHY/MAC parameters as shown in Table 3.2.1.1-8. 

Table 3.2.1.1-8  Settings for DCI #0 

DCI #0 

CORESET Number 0 
First CCE Index In CORESET 0 

Aggregation Level 2 
Data Type PN9 
Init Data 01FF 
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11. Click PDSCH #0 in Slot #0 in the tree view and set the PHY/MAC 
parameters as shown in Table 3.2.1.1-9.  

Table 3.2.1.1-9  Settings for PDSCH #0 

PDSCH #0 

Data Status Enable 
Power Boosting 0.000 dB 

Number of Layers 1 
Number of Code words 1 
Antenna Port Number 1000 

nRNTI 0000 
nID Status Enable 

nID 0 
Modulation Scheme 256QAM 

PDSCH mapping type A 
Symbol Start 3 

Symbol Length 11 
Data Type PN9 
Init Data 01FF 

 
12. Click DMRS in PDSCH #0 in Slot #0 in the tree view and set the 

PHY/MAC parameters as shown in Table 3.2.1.1-10.  

Table 3.2.1.1-10  Settings for DMRS 

DMRS 

nSCID 0 
DMRS nSCID Data Type Cell ID 

DMRS nSCID 0 
DMRS Length 1 

DMRS Additional Position 0 
DMRS Configuration Type 1 

Number of DMRS CDM groups 
without Data 

2 

DMRS Power Boosting 3.000 dB 
 
13. Right-click Slot #0 in the tree view and select Copy. Then, right-click 

one of Slot #1 to 19 and select Paste all.  

14. Click the Calculation to display the Export File screen. Enter 
“5GNR_TDD” and “Downlink_100MHz” for the Package and Export 
File Name, respectively. Then click OK.  

15. The Calculation screen is displayed. After the calculation is 
completed, click OK to finish the waveform generation. 

16. The following files are output in the folder specified in 3.1.6 “Export 
File screen”: Downlink_100MHz.wvi, Downlink_100MHz.wvd 
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3.2.1.2 Uplink 

This section shows a procedure to create a 5G NR TDD sub-6GHz uplink 
waveform pattern for example. 

<Procedure> 

Procedure for generating Uplink waveform 

1. Start this software.  

2. Set the common parameters as shown in Table 3.2.1.2-1. The 
parameters that are not shown below are used with their default 
values, or are automatically set according to other parameter 
settings. 

Table 3.2.1.2-1  Settings for Common Parameters 

Common 

Test Model Off 
Number of Antennas 1 

Cell ID 0 
NID(1) 0 
NID(2) 0 

Number of Frames 1 
Oversampling Ratio 2 

Sampling Rate 61.44 
Bandwidth 20 

Number of RBs (Max RB) 51 
Downlink/Uplink Uplink 

Multiplexing Scheme CP-OFDM 
Cyclic Prefix Normal 

Subcarrier Spacing (SCS) 30 
Filter On 

Phase Compensation On 
Carrier Frequency 3750 MHz 

 

3. Click Uplink of Slot #0 in the tree view and set the PHY/MAC 
parameters as shown in Table 3.2.1.2-2.  

Table 3.2.1.2-2  Settings for Uplink 

Uplink 

Data Status Enable 
Number of PUSCHs 1 
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4. Click PUSCH of Slot #0 in Uplink in the tree view and set the 
PHY/MAC parameters as shown in Table 3.2.1.2-3. 

Table 3.2.1.2-3  Settings for PUSCH 

PUSCH 

Data Status Enable 
Power Boosting 0.000 dB 

Number of Layers 1 
Number of Code words 1 
Antenna Port Number 0 

nRNTI 0000 
nID Status Disable 

nID 0 
Modulation Scheme QPSK 

PUSCH mapping type A 
RB Start 0 

Number of RBs 51 
Symbol Start 0 

Symbol Length 14 
Data Type UL-SCH 

 

5. Set the PHY/MAC parameters of UL-SCH of PUSCH in Slot #0 in 
Uplink in the tree view as shown in Table 3.2.1.2-4.  

Table 3.2.1.2-4  Settings for UL-SCH 

UL-SCH 

Rate Matching FBRM 
MCS Index 4 
MCS Table 64QAM 

Redundancy Version 0 
Transport Block Size 4352 

Data Type PN9 
Init Data 01FF 
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6. Set the PHY/MAC parameters of DMRS of PUSCH in Slot #0 in 
Uplink in the tree view and as shown in Table 3.2.1.2-5.  

Table 3.2.1.2-5  Settings for DMRS 

DMRS 

nSCID 0 
DMRS nSCID Data Type Cell ID 

DMRS nSCID 0 
DMRS Length 1 

DMRS Additional Position 1 
DMRS Configuration Type 1 

Number of DMRS CDM groups 
without Data 

2 

DMRS TypeA Position 2 
DMRS Power Boosting 3.000 dB 

 
7. Right-click Slot #0 in the tree view and select Copy. Then, right-click 

one of Slot #1 to 19, and select Paste all.  

8. Click the Calculation to display the Export File screen. Enter 
“5GNR_TDD” and “G-FR1-A1-5” for the Package and Export File 
Name, respectively. Then click OK.  

9. The Calculation screen is displayed. After the calculation is 
completed, click OK to finish the waveform generation.  

10. The following files are output in the folder specified in 3.1.6 “Export 
File screen”: G-FR1-A1-5.wvi, G-FR1-A1-5.wvd 
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3.3 Saving/Reading Parameters 
The numeric values and settings for each item can be saved in a 
parameter file by using this software.  

3.3.1 Saving a parameter file 
When running on PC, or MS269xA 

1. Select Save Parameter File from the File menu or click the   
tool button to display the parameter file saving screen. 

 

 

Figure 3.3.1-1  Parameter file saving screen 

 

2. Specify Save in, enter a file name in the File name text box, and 
click Save to save the parameter file.  

 

When running on MG3710A 

1. Click the Save Parameter File button in File menu or click the   
button to display the parameter file saving screen.  

 

Figure 3.3.1-2  Parameter file saving screen (MG3710A) 
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2. Select the folder to store the file in the Directories field, and then 
enter the name of the file using the File Name box. Click OK to save 
the parameter file. To initialize the setting in the Directories field, 
click the Default Root button. 
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3.3.2 Reading a parameter file 
When running on PC, or MS269xA 

1. Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen. 

 

 

Figure 3.3.2-1  Parameter file reading screen 

 

2. Select a parameter file to be read from the file list, and then click 
Open to read the selected parameter file.  

 

When running on MG3710A 

1. Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen.  

 

Figure 3.3.2-2  Parameter file reading screen (MG3710A) 

 

2. Select the directory where the files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK. To initialize the setting in the Directories field, click the Default 
Root button. 
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3.4 User File Reading Screen 
When running on PC or MS269xA 

1. When User File is selected for Data Type in the tree view, the user 
file reading screen as shown in is displayed.  

 

 

Figure 3.4-1  User file reading screen 

 

2. Select a user file to be read from the file list, and then click Open to 
read the selected user file.  

An error dialog box is displayed when an invalid file is selected. Refer to 
Appendix B “User File Format” for details on the user file format. 

When running on MG3710A 

1. When User File is selected for Data Type in the tree view, the user 
file reading screen is displayed.  

 

 

Figure 3.4-2  User file reading screen (MG3710A) 
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2. Select the directory where the user files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK. To initialize the setting in the Directories field, click the Default 
Root button.  

If an unsupported User File is selected, an error is displayed. Refer to 
Appendix B “User File Format” for details on the user file format. 
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3.5 Displaying Graph 
The generated waveform pattern can be displayed in a CCDF, FFT, and 
Time Domain graph by using this software. For details of each graph 
display, refer to each one of the following: 

 MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™) 
4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.13 “Time 
Domain Graph Display” 

 MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Signal 
Analyzer Vector Signal Generator Operation Manual (IQproducer™) 
4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.9 “Time 
Domain Graph Display” 

 

Displaying CCDF graph 

1. Generate a waveform pattern menu by executing “Calculation”. 

2. Select CCDF from the Simulation menu or click the  tool 
button. The CCDF Graph Monitor screen shown in Figure 3.5-1 is 
displayed with the trace of the generated waveform pattern.  

 

Figure 3.5-1  CCDF Graph Monitor screen 

 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the 
CCDF Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed in either of the following two 
methods:  
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 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

 Note: 

The CCDF, FFT, and Time Domain graphs cannot be 
generated at the same time. When displaying one graph while 
another graph is being displayed, execute the graph generation 
of the former after that of the latter is completed. 

 

 

■ Displaying the new trace in the same screen as the previous traces 

1. Set Add for Quick Add Mode on the lower-left of the CCDF Graph 
Monitor screen. 

2. Select CCDF from the Simulation menu or click the  tool 
button. The trace of the waveform pattern newly generated is 
additionally displayed in the CCDF Graph Monitor screen. 
Up to eight traces can be displayed by repeating this procedure. 

 
■ When deleting the previous traces to display a new trace 

1. Set Clear for Quick Add Mode on the lower-left of the CCDF 
Graph Monitor screen. 

2. Select CCDF from the Simulation menu or click the  tool 
button. The confirmation message shown in Figure 3.5-2 below 
appears: 

 

Figure 3.5-2  Confirmation message 

 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed. 
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Displaying FFT graph 

1. Generate a waveform pattern by executing “Calculation”. 

2. Select FFT from the Simulation menu or click the  tool 
button. The FFT Graph Monitor screen shown in Figure 3.5-3 is 
displayed with the trace of the generated waveform pattern.  

 

 

Figure 3.5-3  FFT Graph Monitor screen  

 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the FFT 
Graph Monitor screen, the trace of the waveform pattern newly 
generated can be displayed in either of the following two methods:  

 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

 Note: 

The CCDF, FFT, and Time Domain graphs cannot be 
generated at the same time. When displaying one graph while 
another graph is being displayed, execute the graph generation 
of the former after that of the latter is completed. 
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■ Displaying the new trace in the same screen as the previous traces 

1. Set Add for Quick Add Mode on the lower-left of the FFT Graph 
Monitor screen. 

2. Select FFT from the Simulation menu or click the  tool 
button. The trace of the waveform pattern newly generated is 
additionally displayed in the FFT Graph Monitor screen. 
Up to four traces can be displayed by repeating this procedure. 

■ When deleting the previous traces to display a new trace: 

1. Set Clear for Quick Add Mode on the lower-left of the FFT Graph 
Monitor screen. 

2. Select FFT from the Simulation menu or click the  tool 
button. The confirmation message shown in Figure 3.5-4 below 
appears: 

 

Figure 3.5-4  Confirmation message 

 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed.  
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Displaying the Time Domain graph 

1. Generate a waveform pattern by executing “Calculation”. 

2. Select Time Domain from the Simulation menu or click the  
tool button. The Time Domain Graph Monitor screen shown in 
Figure 3.5-5 is displayed with the trace of the generated waveform 
pattern.  

 

Figure 3.5-5  Time Domain screen 

 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the Time 
Domain Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed in either of the following two 
methods: 

 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

 Note: 

The CCDF, FFT, and Time Domain graphs cannot be 
generated at the same time. When displaying one graph while 
another graph is being displayed, execute the graph generation 
of the former after that of the latter is completed. 
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■ Displaying the new trace in the same screen as the previous traces 

1. Set Add for Quick Add Mode on the lower-left of the Time 
Domain Graph Monitor screen. 

2. Select Time Domain from the Simulation menu or click the  
tool button. The trace of the waveform pattern newly generated 
is additionally displayed in the Time Domain Graph Monitor 
screen.  
Up to four traces can be displayed by repeating this procedure. 

 

■ When deleting the previous traces to display a new trace 

1. Set Clear for Quick Add Mode on the lower-left of the Time 
Domain Graph Monitor screen. 

2. Select Time Domain from the Simulation menu or click the  
tool button. The confirmation message shown in Figure 3.5-6 
below appears: 

 

Figure 3.5-6  Confirmation message 

 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed.  
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3.6 Auxiliary Signal Output 
Select a waveform pattern generated by the 5G NR TDD sub-6GHz 
IQproducer™ on this equipment to output the marker that is 
synchronized with the RF signal as an auxiliary signal from the AUX on 
the rear panel of this equipment. Markers described below are 
automatically set for the waveform patterns when they are generated. By 
using the Marker Edit function which is a peripheral function of the 
Time Domain graph, a waveform pattern can be generated with these 
markers edited.  

For details of Marker Edit function, refer to each one of the following: 

 MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A  
Analog Signal Generator Operation Manual (IQproducer™) 
4.13.12 “Marker edit function” 

 MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Signal 
Analyzer Vector Signal Generator Operation Manual (IQproducer™) 
4.9.12 “Marker edit function” 

 

As auxiliary signal, Frame Pulse (Connector 1) is output. Connector 2, 3 
are not used.  

 Frame Pulse 
A pulse that is synchronized with the symbol at the beginning of the 
subframe is output from Connector 1. Change Polarity for Marker 1 to 
change the signal polarity.  

 

For the error range of the auxiliary signals against the RF output, refer 
to each one of the following: 

 MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A  
Analog Signal Generator Operation Manual (IQproducer™) 
4.5.6 “Input file format” 

 MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Signal 
Analyzer 
Vector Signal Generator Operation Manual (IQproducer™) 
4.5.6 “Input file format” 
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The following operations are required to output a modulated signal from 
this equipment using the waveform pattern generated by this software: 

• Transferring waveform pattern to internal hard disk 
• Loading waveform patterns from the hard disk to the waveform 

memory 
• Selecting a waveform pattern to be output from this equipment 
 
This chapter explains the details of these operations. 

 
5.1 For MG3710A ............................................................ 5-2 

5.1.1 Transferring waveform pattern to internal  
hard disk ........................................................ 5-2 

5.1.2 Loading to Waveform Memory ...................... 5-4 
5.1.3 Selecting Waveform Pattern .......................... 5-5 

5.2 For MS2690A/MS2691A/MS2692A ........................... 5-6 
5.2.1 Transferring waveform pattern to internal  

hard disk ........................................................ 5-6 
5.2.2 Loading to Waveform Memory ...................... 5-6 
5.2.3 Selecting Waveform Pattern .......................... 5-7 
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5.1 For MG3710A 
This section describes how to download a waveform pattern created for 
the MG3710A to the hard disk of the MG3710A and output the pattern.  

5.1.1 Transferring waveform pattern to internal hard disk 
The waveform pattern created with this software can be transferred to 
the internal hard disk in the following ways:  

• LAN 
• External device such as USB flash drive 

Note: 
This operation is not necessary if you are using MG3710A and 
have generated waveform patterns on MG3710A.  

■Transferring from PC via LAN (MG3710A) 
Two IQproducer™ tools can be used to transfer a waveform pattern to 
the MG3710A via a LAN.  

• Transfer & Setting Wizard 
Start this wizard by clicking the Transfer & Setting Wizard button of 
this software or by selecting Simulation & Utility tab → Transfer & 
Setting Wizard from the IQproducer™ after creating a waveform 
pattern. For details, refer to Section 4.7 “File Transfer and Loading to 
Memory Using Transfer & Setting Wizard” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™).  
Transferring a waveform pattern to the internal hard disk of the 
MG3710A, loading the waveform from the hard disk to the waveform 
memory, and then outputting the waveform pattern can be done using 
this wizard.  

• Transfer & Setting Panel 
This function is loaded by selecting Transfer & Setting Panel in the 
Simulation & Utility tab of the IQproducer™. For details, refer to 
Section 5.2 “Transferring Waveform Pattern” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™).  
Specify the folder that contains the waveform pattern to transfer to 
the MG3710A in the PC-side tree of Transfer & Setting Panel. 
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■Transferring via external device such as USB flash drive (MG3710A) 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MG3710A, refer to Section 7.3.6 “Copying 
external waveform pattern: Copy” in the MG3710A/MG3710E Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(Mainframe).  
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5.1.2 Loading to Waveform Memory 
To output a modulated signal using a waveform pattern, it is necessary to 
load the waveform pattern that was transferred to the internal hard disk 
of the MG3710A (described in Section 5.1.1 “Transferring waveform 
pattern to internal hard disk”) to the waveform memory. A waveform 
pattern can be loaded into the waveform memory in the following two 
ways.  

■Configuring using the mainframe  
A waveform pattern can be loaded into the waveform memory by using 
the instruction panel of the MG3710A or by using a remote command.  

For operation using the front panel, refer below: 

• Section 7.3.4 “Loading waveform pattern: Load” in the 
MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 

For operation using remote commands, refer below: 

• Section 7.3.4 “Loading waveform pattern: Load” in the 
MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 

■Using Transfer & Setting Panel of IQproducer™ 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory by using Transfer & Setting Panel, which can be opened from 
the Simulation & Utility tab. For details, refer to Section 4.6 “File 
Transfer and Loading to Memory Using Transfer & Setting Panel” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™). 
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5.1.3 Selecting Waveform Pattern 
Select a waveform pattern to use for modulation from the waveform 
patterns loaded into the waveform memory of the MG3710A according to 
Section 5.1.2 “Loading to waveform memory”. A waveform pattern can be 
selected in the following two ways. 

■Configuring using the MG3710A 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.  

For operation using the front panel, refer below:  

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 

For operation using remote commands, refer below: 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 

■Using Transfer & Setting Panel of IQproducer™ 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory, and also selected for modulation. This is done by using Transfer 
& Setting Panel, which can be opened from the Simulation & Utility tab. 
For details, refer to Section 4.6 “File Transfer and Loading to Memory 
Using Transfer & Setting Panel” in the MG3700A/MG3710A/MG3710E 
Vector Signal Generator MG3740A Analog Signal Generator Operation 
Manual (IQproducer™). 
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5.2 For MS2690A/MS2691A/MS2692A 
This section describes how to download a waveform pattern created for 
the MS269xA to the hard disk of the MS269xA and output the pattern.  

 

5.2.1 Transferring waveform pattern to internal hard disk 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MS269xA, refer below:  

• Section 2.4.4 “Copying waveform file(s) to hard disk” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

Note:  
Transferring waveform patterns is not required if the patterns are 
created using this software. 

5.2.2 Loading to Waveform Memory 
In order to output a modulated signal using the waveform pattern, it is 
necessary to load the waveform patterns stored in the internal hard disk 
to the waveform memory.  

■Loading to Waveform Memory 
Waveform patterns can be loaded to waveform memories by operating the 
panel or by using a remote command.  

For operation using the front panel, refer below: 

• Section 2.4.1 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 
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5.2.3 Selecting Waveform Pattern 
Select waveform patterns to be used for modulation from those loaded in 
the waveform memory as described in Section 5.2.1 “Transferring 
waveform pattern to internal hard disk” above. 

■Selecting waveform pattern 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.   

For operation using the front panel, refer below: 

• Section 2.4.2 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 
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A list of error messages is shown below. In this list, x, n1, and n2 indicate 
a numeric value, and s indicates a character string. 

Table A-1  Error messages 

Error Message Description 
DCI #x and DCI #y overlap. — 
DCI #x is out of range in CORESET #y. — 
PUSCHs are overlapping. The mappings of PUSCH #x and PUSCH #y are 

overlapping. (This error message is for PUSCH 
only. The same error does not happen to PDSCH.) 

All PDSCHs shown in the tree view must be 
assigned to one or more RBs. — 

Available memory is low. — 
Calculation cannot start because of setting error. — 
Cannot open file. — 
Cannot read file. — 
Cannot read file(“s”). — 
Cannot write file. — 
Cannot write file(“s”). — 
Data size is too large. — 
Input a value that fulfills 2^a×3^b×5^c where a, 
b, c, is a set of non-negative integers. — 

Input Export File Name. — 
Input Package Name. — 
Invalid file format When loading complex data, this message is also 

displayed if binary data is loaded by mistake. 
Invalid value is set. — 
Operation disabled when 2nd vector SG (Opt-062, 
064, 066) not installed.  — 

The Setting value is out of range.(“s = x(n1 – n2)”) The value of x set in parameter s is out of the 
setting range between n1 and n2. 
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A list of warning message is shown below. 

Table A-2  Warning message 

Warning Message Description 
Clipping was done. — 
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This section shows example of the user file format that can be used in 
this software. A user file must be a text file. It is not necessarily required 
to specify an extension to user files. Note that an error occurs if a user 
file that does not conform to the format is read.  

Be sure to write an unmodulated binary sequence into a user file. An 
error occurs if a user file that contains characters other than 0, 1, line 
feed, comma, period, and space is read. All line feeds, commas, periods, 
and spaces in a user file are ignored when the user file is read. 
A user file format example is shown below. 

User file format example   

0s and 1s in a user file are sequentially read from the leftmost of the first 
line. 
When the number of data to be processed is larger than that in the user 
file, the user file is read again from the top. If the user file contains more 
data than that to be processed, data reading terminates halfway. 
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